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1  ORGANIZATION OF THE HW4 MANUALS 
The HW4 manuals are organized in separate books so as to limit the size of the individual documents. A list 
of the HW4 manuals is provided in document E-M-HW4v3-DIR 
 
HW4 Manuals Contents 

HW4 Main Book 

General software description 
Installation, start-up and settings 
Device connection methods 
Functions common to all devices used with HW4 

Device Specific Functions 1 
(separate book for each device type or model) 

Legacy devices (original HygroClip technology): 
 
o HygroLog NT data logger 
o HygroFlex 2, HygroFlex 3 and M3 transmitters 
     (same icon in device tree) 
o HygroLab 2 and HygroLab 3 bench indicators 
o HygroPalm 2 and HygroPalm 3 portable indicators 
o HygroClip DI digital interface 
o HygroClip Alarm programmable logic 
o HygroStat MB 
 
Device Manager (device configuration) and other device 
specific functions 

Probe Adjustment 1 Humidity and temperature adjustment function common to 
all legacy devices (original HygroClip technology) 

Device Specific Functions 2 
(separate book for each device type or model) 

Devices based on the AirChip 3000 technology: 
 
o HygroClip 2 (HC2) probes 
o HF3 transmitters and thermo-hygrostats 
o HF4 transmitters 
o HF5 transmitters 
o HF6 transmitters 
o HF7 transmitters 
o HF8 transmitters 
o HL20 and HL21 data loggers 
o HP21, HP22 and HP23 hand-held indicators 
o Custom designed OEM products 
 
Device Manager (device configuration) and Data Logging 
functions 

Probe Adjustment 2 Humidity and temperature adjustment function common to 
all devices based on the AirChip 3000 technology 

Data Recording Data recording function common to all devices based on the 
AirChip 3000 technology 

 
Both the HW4 manuals (software) and device specific manuals (hardware) are available from the HW4 CD. 
The manuals can also be downloaded from several of the ROTRONIC web sites. 
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2  OVERVIEW 
This section of the HW4 manual covers only the following HW4 modules: 
 
HW4 Functional Modules for the HF8 Usage 
Device Manager o HF8 user configurable settings and functions 

Record Data o Data logging by the HF8 
 
o HW4 functions that are not device dependent are covered in the HW4 manual E-IN-HW4v3-Main. 
 

2.1   Functions and settings overview 
 
By itself, the HC2 probe (HygroClip 2) used with the HF8 transmitter is already a full-fledged measuring 
instrument that can be used as a stand-alone device. The role of the HF8 transmitter indicator is to provide 
power to the HC2 probe and to offer additional functionality and features such as: local data display, local 
keypad for accessing most settings and functions, calculation of additional psychrometric parameters, data 
logging, analog output signals, digital output signals, relay outputs and probe adjustment.   
 
It is important to note that when used together, the HF8 transmitter and HC2 probe (HygroClip 2) constitute 
a 2-component system. Each system component has its own microprocessor, firmware and functions. Some 
of these functions are unique to each system component. Other functions are found in both components.  
 
The functions and settings of the HF8 transmitter and HygroClip 2 probe (HC2) operate together as 
indicated below: 
 

Function / Setting HF8 HC2 Notes 

Device protection X X Individual to the HF8 and HC2 probe 
RS-485 address X X Individual to the HF8 and HC2 probe 

Device Name X X 
User defined description 
The device name of the HC2 probe is not displayed by HW4 and is 
replaced with the HF8 Input Name 

Calculation X X Psychrometric calculation 
HF8 setting overrides HC2 probe setting 

Fixed pressure 
value X  Barometric pressure used for some psychrometric calculations 

Data refresh rate X  The data refresh rate of the HF8 is set a 1 sec. and cannot be 
changed. 

Simulator function X X Generates fixed humidity and / or temperature value 
When enabled, HF8 settings override the HC2 probe settings 

Unit system X X HF8 setting overrides HC2 setting regarding the HF8 
HC2 probe settings still apply at the level of the probe 

Out-of-limits value 
alarm X X 

Hi and Lo alarm values can be set for each of the two probe inputs of 
the HF8. These values can be used to trigger a digital alarm or to 
control the action of the HF8 optional relay outputs. The HF8 alarm 
settings are independent from the HC2 probe settings. 
 
The HF8 does not monitor out-of-limit values defined at the level of 
the probe. Out-of-limit values should be defined at the level of the 
HF8. 
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Function / Setting HF8 HC2 Notes 

Analog outputs  X Parameter and scale 
HC2 probe settings have no effect on the HF8 

Display X  No effect on the HC2 probe 
Automatic RH 
sensor test and 
compensation 

 X The sensor status can be read with HW4 but not with the HF8 display 

Sensor alarm and 
sensor failure mode  X 

The HC2 probe can be configured to trigger an alarm when the RH 
sensor test returns a bad result. Independently of the RH sensor test, 
the HC2 probe will trigger an alarm in the event of a major failure of 
either the RH or temperature sensor (shorted or open sensor). 
 
Additionally, the HC2 probe can be configured to generate a fixed 
value for humidity and temperature whenever a sensor alarm is 
triggered. 
 
The HF8 will display an alarm when the RH sensor test returns a bad 
result and will also do so for any shorted or open sensor. 
 

Data logging X X 

Data logging by the HF8 can be started or stopped from the HF8 
optional keypad.  All log settings can be changed from the HF8 
keypad. 
 
Data recording by the HC2 probe itself cannot be started or stopped 
with the HF8 keypad 
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2.2   Detecting the HF8 transmitter with HW4 
 
Use a service cable to connect the service connector of the HF8 transmitter to the HW4 PC. Unless already 
installed, you should install the ROTRONIC USB driver on the PC before running HW4. Proceed as 
indicated in document E-IN-HW4v2.1-Main. 
 

 
 
 
After detection by HW4, the HF8 appears as an icon in the left 
pane of the HW4 main screen. 
 
 
 
 

 

 
 
 
 
 
Click on the + sign to the left of the HF8 icon to display the HF8 
Device Manager module, the Record Data module as well as two 
probe icons (one for each of the HF8 inputs). When no probe is 
connected, a red cross appears on top of the probe icon. 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
Click on the + sign to the left of a probe icon to display a list of the 
available functional modules for the probe. 
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3  DEVICE MANAGER 
 
Device Manager is used to configure the HF8. 
 

 
 
 
 
 
To select the Device Manager for the HF8, click on it with the left 
mouse button. HW4 opens the Device Manager form. 
 
 
 
 
 
 
 

 
Device Manager automatically interrogates the HF8 and downloads its current configuration. 
 

 
 
The different sub-forms that are available within the Device Manager form are listed in a tree located on the 
left pane of the form. To select a sub-form, click on it with the left mouse button. 
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3.1   Device Manager Menu Bar 
The Device Manager menu bar is located at the top of the form. 
 
File 
 
The file menu is used to save to the PC, or to retrieve from the PC, the configuration settings of the HF8. 
The settings are saved in an XML file with the extension DAT. Saving the configuration settings to a file is 
useful for several reasons: 
 

- provides a backup when the device configuration has been changed in error 
- provides a means of quickly configuring a replacement device in the exact same manner as the 

original device 
- provides a means of quickly configuring a number of identical devices  

 
Open: opens the device configuration folder specified in HW4 Global Settings - File Locations Tab - and 
displays all available probe and device configuration files (extension DAT). Select the appropriate file and 
click on Open in the explorer form. The contents of the configuration file are loaded to the Device Manager 
form. Review the contents of the Device Manager sub-forms. Click on the Device Manager OK button to 
write the configuration settings to the device or click on the Cancel button to leave the device unchanged. 
 

 
 
 
Save As: saves the current configuration to an XML file with the extension DAT) in the device configuration 
folder specified in HW4 Global Settings - File Locations Tab. If so desired, any directory and any file type 
may be specified. 
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Exit: exits Device Manager 
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Tools 
 
Firmware Update: This tool is used to update the firmware of the HF8 after downloading a new firmware file 
from the ROTRONIC website to your PC. Firmware files are given a name that shows both to which device 
the file applies and the version number of the firmware. All firmware files have the extension HEX. The 
ROTRONIC website will publish firmware updates as required. 
 
The tool opens a form that allows you to specify the folder where the firmware update file is located and to 
select the file. Click on OPEN to start the update process. 
 

 
 
IMPORTANT: the HF8 must be powered during the entire process. Loss of power when the transmitter is 
being updated may have unexpected results and prevent future operation of the HF8.  
 
Generate Protocol: generates a Device Configuration Protocol. This text file is automatically saved in the 
folder specified in HW4 Global Settings - File Locations Tab. If so desired, any directory and any file type 
may be specified. This action is not recorded in the User Event file.  
 
Help: 
 
HW4 Help: Opens HW4 Help 
 
About HW4: Displays the version number and ID number of HW4 
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3.2   Device Information 
 

 
 

RS485 Address: click on the underlined blue link to change the transmitter address to be used in 
conjunction with an RS-485 network (multi-drop). Each network address should be unique and within the 
values of 1 to 64. Note: the default factory RS-485 address is 0. Click on the Device Manager OK button to 
write the new address to the transmitter. 
 
Write Protection: This function is used to prevent unauthorized access to critical functions such as 
configuration changes, humidity and temperature adjustment, etc. Click on the underlined link next to Device 
Protection. HW4 opens the following form where a password can be entered (maximum 8 characters): 
 
 
 
 

 
 
 
 
 
 
 
 
 

Click on the Device Manager OK button to write the new protection settings to the HF8. 
 
FORGOT THE PASSWORD? - Power down the HF8. After powering up the HF8, you have about one 
minute to use the default password !resume! (include the exclamation marks). After one minute the default 
password is no longer accepted. 
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3.3   Settings 
 

 
 
Device Name: As far as possible use a unique device name (maximum 12 characters) 
 
Fixed Pressure Val.: enter here the fixed numerical value to be used for barometric pressure when 
calculating the following parameters: Wet bulb temperature, Enthalpy, Specific humidity and Mixing ratio by 
weight. This numerical value should correspond to the typical barometric pressure at your elevation (or in 
your process) and should be consistent with the unit system that is being used.  Note: when one of the two 
probe inputs is set for an analog pressure probe, the pressure measured by the probe is used instead of the 
fixed pressure value. 
 
Data Refresh Rate: the HF8 uses a non adjustable data refresh rate of 1 second. 
 
Set to PC Date and Time: click on this link to immediately set the clock of the HF8 to the date and 
 time of the PC. Do not use this link when the HF8 is recording data. 
 
Audible Alarm: the HF8 can emit a sound when an alarm condition occurs (out-of-limit value, loss of 
communication with a probe, etc.). The audible alarm function can either disabled or configured as shown 
below: 
 

Latching mode: regardless of the status of the alarm, this mode 
requires a manual cancellation of the alarm with the HW4 
software 
 
Cancel after …: when the alarm condition no longer exists, the 
audible signal is automatically silenced after the indicated time 
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Two blue links are provided to test or to manually cancel the audible alarm. The audible alarm must be 
cancelled after a test.  
 

3.4   Unit System 
 

 
 
 
 Humidity: enter here the letters to be used after the “%” symbol used for relative humidity 
 
Temperature and other parameters: Left click on the arrow to the right of the text box and select the 
engineering unit. 
 
Click with the mouse on the blue links labeled Metric or English to globally set the unit system for all 
parameters. 
 
Time Format, Date Format, Date Separator: these settings can be changed to match your preferences 
practices 
 
 
Note: The unit system selected for the HF8 overrides the unit system selected for the probe.  
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3.5   Input 1 / Input 2 
Type of Probe: any of the HF8 two probe inputs can be set to accept either a digital HygroClip 2 probe or 
an analog probe. Click on the blue link on the top right corner of the form to change the type of probe. 

3.5.1 Digital HygroClip 2 Probe 
 

 
 
Description: enter here a description for the probe input (maximum 12 characters). This text can be 
displayed in the HW4 current Values tab.  
 
Calculation: Left click on the arrow to the right of the text box and select from one of the available 
psychrometric calculations:  
 

 
Notes: 
 
Dew Point: calculates the dew point above and below freezing 
 
Frost Point: calculates the frost point below freezing and the dew 
point above freezing 
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Lo-Alarm, Hi-Alarm, Hysteresis: Alarm conditions can be defined for humidity, temperature and the 
calculated parameter. Values that are below the low alarm value or above the high alarm value will trigger 
an alarm. The value specified for the alarm function hysteresis is used for both the low and the high alarm. 
 
All versions of HW4 show an out-of-limits value alarm by using red characters on the monitor screen. In 
addition, HW4 Professional can be configured (HW4 global settings - Alarm settings tab) to display an alarm 
table and generate a report whenever an out-of-limits condition occurs. 
 
Note: in general, enable this alarm function only at the level of the HF8 and not at the level of the probe 
 
Generate Humidity Fixed Value / Generate Temperature Fixed Value: place a check mark in these boxes 
to make the HF8 generate fixed humidity and temperature values instead of reporting the actual 
measurements. 
 
The fixed values must be within the following limits: -999.99 and 9999.99 
 
When the humidity and/or temperature signal is set to a fixed value, this is reported on the HW4 main screen 
(current Values tab) as shown below. In addition, an entry is made in the Alarm Table (HW4 Professional) 
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Simulator Action table 
 

HF8 simulation Probe simulation HW4 and HF8 signals / display 

enabled enabled or disabled HF8 simulated values 

disabled enabled Probe simulated values 

disabled disabled Actual measurement values 
 
 
 Generate fixed values when probe connection is lost: place a check mark in this box to make the HF8 
generate fixed humidity and temperature values whenever communication with the probe is lost. The fixed 
values are the same as specified under Generate Humidity Fixed Value / Generate Temperature Fixed 
Value. 
 
 
HW4 and the HF8 monitor the alarms generated at the level of the HygroClip 2 probe as indicated in the 
table below: 
 
HC2 probe alarm HW4 HF8 
Out-of-limit value Not  monitored Not  monitored 

RH sensor test 
result = Bad 

- Warning appears on monitor screen 
- Entry in alarm table 
- When the Fail Safe Mode is enabled 
  (Probe Device Manager), the parameter 
   corresponding to the faulty sensor 
   takes a fixed value as per the HC2 
   probe settings. 

- Sensor Alarm appears at the bottom of 
  local display 
- When the Fail Safe Mode is enabled 
  (Probe Device Manager), the parameter 
   corresponding to the faulty sensor 
   takes a fixed value as per the HC2 
   probe settings. 

Major sensor 
failure (shorted or 
open sensor) 

- Warning appears on monitor screen 
- Entry in alarm table 
- When the Fail Safe Mode is enabled 
  (Probe Device Manager), the parameter 
   corresponding to the faulty sensor 
   takes a fixed value as per the HC2 
   probe settings..  

- Sensor Alarm appears at the bottom of 
  local display 
- When the Fail Safe Mode is enabled 
  (Probe Device Manager), the parameter 
   corresponding to the faulty sensor 
   takes a fixed value as per the HC2 
   probe settings.. 
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3.5.2 Analog probe and analog pressure probe (single channel) 
 
Note: Do not forget to configure HW4 to display analog input signals (HW4 Main Menu Bar > Settings and 
Tools > Column Headers > Analog Input). 
 

 
 
Description: enter here a description for the probe input (maximum 12 characters). This text can be 
displayed in the HW4 current Values tab.  
 
Voltage range: enter here the minimum and maximum of the probe output signal range. The HF8 accepts 
probes with a voltage signal within the limits of 0 to 3.3 VDC 
 
Measuring  range: enter here the minimum and maximum of the probe measuring range. The values must 
be with the following limits: -999.99 and 9999.99 
 
Unit of Measurement: enter here the unit of measurement that will be displayed by both HW4 and by the 
HF8 (maximum 3 characters). When the pressure probe option is selected, HW4 automatically enters in this 
field, the barometric pressure unit selected in the Units System form.  
 
Lo-Alarm, Hi-Alarm, Hysteresis: Alarm conditions can be defined for the parameter measured by the 
probe. Values that are below the low alarm value or above the high alarm value will trigger an alarm. The 
value specified for the alarm function hysteresis is used for both the low and the high alarm. 
 
All versions of HW4 show an out-of-limits value alarm by using red characters on the monitor screen. In 
addition, HW4 Professional can be configured (HW4 global settings - Alarm settings tab) to display an alarm 
table and generate a report whenever an out-of-limits condition occurs. 
 
Generate Fixed Value: place a check mark in this box to make the HF8 generate a fixed value instead of 
reporting the actual measurement. 
 
The fixed value must be within the following limits: -999.99 and 9999.99 
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When the probe input is set to generate a fixed value, this is reported on the HW4 main screen (current 
Values tab). In addition, an entry is made in the Alarm Table (HW4 Professional) 
 
Generate fixed values when probe connection is lost: place a check mark in this box to make the HF8 
generate a fixed value whenever communication with the probe is lost. The fixed value is the same as 
specified under Generate Fixed Value. 
 
Pressure Probe: select this option when the analog probe measures barometric pressure. When this option 
is selected, the pressure measured by the probe is used as an input for a number of psychrometric 
calculations that may be performed on the other probe input.  
 

3.6   Analog Outputs (optional) 
Depending on the model, the HF8 can provide up to 4 analog output signals. Each individual analog output 
signal can be configured with the following form: 
  

 
 
Analog Signal: select one of the following options:  
 

 
 
Note: The analog signal type applies globally to all outputs. 
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Output 1 to Output 4: click on the output number to be configured. The selected output appears over a blue 
background. 
 
 

 
 
 
Parameter: each analog output can be either disabled or associated with one of the following parameters: 
 

Humidity / Analog 1 (input 1) and Humidity / Analog 2 (input 2): 
 
o When the input is configured for a digital HygroClip 2 probe, the 

output signal corresponds to the relative humidity measured by the 
probe 

 
o When the input is configured for a 1-channel analog probe, the output 

signal corresponds to the parameter measured by the probe. 
 
 
 
Scale: enter the numerical values corresponding to the analog signal minimum and maximum values. 
 

3.7   Display (optional) 
 

 
 
Load Language File: click on this link to change the language of the HF8 internal menu by writing to the 
HF8 the contents of a language file present on your PC  
 
Backlight Mode: click on the arrow to the right of the box and select from Always off, Always on or On Key 
Press 
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Display Mode: select from the following options: RH + T + Date / Time,  RH + T + Calculation or large 
display characters (RH or T or Calculation selected on the HF8 with the ENTER key) and date / time 
 
Resolution: select from the following options one or two decimals 
 
Contrast: use the slider to adjust the contrast of the LC display and click on the Update link to change the 
contrast. Click on the Update link to write the new contrast setting to the HF8.  
 
Trend Indicator Stability: enter in this text field the stability criteria used by the trend indicators. A value of 
0.01 means that when the rate of signal change is less than 0.01 units per minute, the signal is shown as 
stable. 
 
Show Trend Indicator: check this box to enable the trend indicators on the optional local display. Trend 
indication within the HW4 Current Values tab is a Global Setting of HW4 (HW4 Main Menu > Settings and 
Tools > View tab) 
 
Allow Menu Access: put a check mark in this box to prevent access to the internal menu of the HF8 from 
the keypad. 
 
Enable Delta Pbe1 – Pbe2: check this box enable the HF8 to display a fictitious third probe that can be 
selected on the keypad with the UP or DOWN arrow. This probe shows the difference between each of the 
measured or calculated parameter (probe 1 less probe 2). 
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3.8   Relays (optional) 
Depending on the model, the HF8 has up to 4 relay outputs that can be associated with any parameter 
measured or calculated by the HF8 two probe inputs. A relay is energized when the parameter associated 
with the relay is outside of the limits that can be defined as part of the configuration of each probe input.  
 
IMPORTANT: in order to make use of the HF8 relay outputs, you must first enable the alarm function for 
each of the parameters that you want to monitor and also define out-of-limit values. The following screen 
shot provides an example for the relative humidity measured by the digital HygroClip 2 probe connected to 
input 1.  
 

 
 
Each individual relay output can be configured with the following form: 
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To configure each relay output, proceed as follows: 
 
1) Click with the mouse on the relay output to be configured. The selected relay output appears over a 

blue background. 
 

 
 
2) Select the parameter to be associated with the relay output by clicking with the mouse on the box 

located to the left of the parameter. When the parameter is selected, a check mark appears in the box.  
 

 
 
 
Note: Input 1: Humidity or Analog Signal Alarm 
 
o When input 1 is configured for a digital HygroClip 2 probe, the relay is associated with the relative 

humidity measured by the probe connected to input 1 
 
o When the input is configured for a 1-channel analog probe, the relay is associated with the parameter 

measured by the probe connected to input 1. 
 
3) Configure the relay operating parameters 
 

 
 
Time Delay: use this control if you want to prevent the relay from being immediately energized when an 
alarm occurs. If the time delay is not set to zero, the relay will be energized after the specified time provided 
that the alarm condition persists. 
 
De-energize Relay when Alarm ends: when the box is checked, the relay will be de-energized as soon as 
the alarm condition ends 
 
De-energize Relay after (hh:mm:ss): when this box is checked, the relay will remain energized for the 
specified duration even if the alarm condition has ended. 
 
Notes:  
 
o To test the relay operation, click with the mouse on the two blue links labeled “Energize Relay” and “De-

energize Relay” 
o For a purely latching operation of the relay do not check any of the “de-energize” boxes. In that case, 

you will have to use HW4 to manually de-energize the relay (cancel the alarm).  
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4) Optional – define and enable a time schedule for the relay operation 
 

  
 
To define and enable a time schedule for the relay, use the mouse to place a check box in the box labeled 
“Relay Operation Schedule”. 
 
Operation of each individual relay can be restricted to specific days of the week and to specific times. 
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4  DATA RECORDING 
Data Recording is used to configure the data recording functions of the HF8, to start and stop data logging 
by the HF8 and to download the recorded data to the HW4 PC. 
 

 
 
To select Data Recording, click on it with the left mouse button. 
HW4 opens the Data Recording form. 
 
 
 
 
 
 
 
 
 
 
 

4.1   Data logging – Settings 

 
 
This form is used to select the following: 
 

o Recording mode:  
 
Start-Stop: ends the recording when the memory is full 
Loop: when the memory is full, keep recording and dump the oldest data record 
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o Log interval: 5 seconds to 1 hour 
 

o Probe to be recorded: Probe 1, Probe 2 or both 
 
 

Note: when recording two probes simultaneously, the memory of the HF8 is shared equally between the two 
probes meaning that the recording capacity per probe is half of what it would be when just one probe is 
being recorded.  
 

4.2   Data Logging – Data Download 
This form is used to download to the PC the data present in the HF8 memory. The file can be downloaded 
even when data is still being recorded. 
 
Notes: 
 
The file format (text file - .txt or binary - .log) used by HW4 when saving the data to disk can be configured  
from the menu bar of the data logging form: Settings and Tools > Log File Format 
 
HW4 can print a protocol of the Data Logging settings:  Settings and Tools > Generate Protocol 
 
 

 
 
 
Click on the blue link labeled “Start Download” to download the data recorded by the HF8. 
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4.3   Adding a calculated parameter to the log file 
HW4 View Data can be used to add a calculated parameter such as dew point to a log file comprised of 
relative humidity and temperature records. The parameter is calculated for each data record based on the 
relative humidity and temperature values. 
 
HW4 View Data can also be used to replace the calculated parameter in a log file with a different one. 
 
HW4 View Data opens automatically after reading data from the HF8 transmitter. Files that have already 
been downloaded can be opened from the HW4 main menu bar by selecting File > Open. To access the 
“Add / Change calculated parameter” function, click on Tools in the HW4 View Data menu bar and select 
“Add / Change calculated parameter”.  This opens the following form: 

 
 
 
Use the form shown on the left to select one of 
the available calculated parameters. 
 
NOTE: some parameters such as Enthalpy, 
Mixing Ratio etc. require barometric pressure as 
a calculation input. Be sure to enter the correct 
pressure value in the form. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click on the OK button to add the selected calculated parameter or change the existing calculated 
parameter. 
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5  PROBES 
 
NOTE: we recommend using the same humidity symbol and the same temperature unit (°C or °F) for both 
the probe and HF8. 

 
 
 
 
 
Click on the + sign to the left of a probe icon to display a list of the 
available functional modules for the probe. 
 
 
To select a function module, click on it with the left mouse button. 
 
 
 
 
 
 
 
 
 

o The Device Manager module is used to configure the HygroClip 2 probe connected to the HF8 
transmitter and is separately described in the HW4 manual E-M-HW4v3-F2-001 
 

o The Record Data module is common to all probes and instruments based on the AirChip 3000 
technology and is separately described in the HW4 manual E-M-HW4v3-DR-001 
 

o The Probe Adjustment module is used calibrate and adjust the probe humidity and temperature signals. 
This module is common to all probes and instruments based on the AirChip 3000 technology and is 
separately described in the HW4 manual E-M-HW4v3-A2-001 
 

o HW4 functions that are not device dependent are covered in the HW4 manual E-IN-HW4v3-Main. 
 

 

6  DOCUMENT RELEASES 
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